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Training at a Glance

Use this as a guide to select specific workflows to be covered.

TOPICS STEP BY STEP WORKFLOWS
PRODUCT ® Benefits of using QuickBooks Online
OVERVIEW ® Know the features of your QuickBooks Online subscription

IMPORTING DATA ® Export QuickBooks Desktop data to QuickBooks Online
® Importing lists into QuickBooks Online

SETTING UP YOUR e Add users to QuickBooks Online
COMPANY ® Products and Services list

Print a transactions report for a selected account directly from the
Chart of Accounts

Print the Chart of Accounts
Connect a bank account to the bank feed
Company tab in global Company Settings

Enter contact information, employer ID and tax form in global
Company Settings

Specify terminology for customers in global Company Settings
Sales tab in global Company Settings

Turn on inventory in global Company Settings

Expenses tab in global Company Settings

Explore purchase orders in Account and Settings

Advanced tab in Account and Settings

Close the books in Account and Settings

Show account numbers in Account and Settings

Enable auto-recall on forms in Account and Settings

Enter/Edit many account numbers at once in the Chart of Account

Change settings for automatic signing out after a period of inactivity
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QuICKBOOKS ONLINE TEST DRIVE

Exercises contained inside this handbook can be completed using a QuickBooks Online “test drive”
file. The test drive uses a sample company file called Craig’s Design & Landscaping Services. It can
be accessed through the following link:

Craig's Design & Landscaping

You don't have to create an account or sign in to access the test drive file; just complete the security
validation and click Continue.

This test drive is designed for you to explore and try out new things without worrying you will break
something or make a mistake. It is not designed to retain any changes you make. (Although you
should change the Sign me out if inactive for setting to 3 hours if you want to give yourself plenty of
time.) Once you close this QuickBooks Online test drive company it is completely refreshed, so
remember to allow sufficient time to complete each task.
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Topic 1: Product Overview

QuickBooks Online has many features and advantages that QuickBooks Desktop does not offer.
Once you make the change to QuickBooks Online, it is important to understand the features
available to you by being in the cloud and the feature availability based upon your subscription
level. Look at just some advantages that QuickBooks Online has:

Access data easily across multiple platforms, PC or Mac, browser or tablet
Mobile access included with all QuickBooks Online subscriptions at no additional cost
No need to transfer data files since everyone logs in to the same account to access the same data

All the data is hosted, backed up and secured by Intuit's servers

Automatically create invoices and send them to clients, including delayed customer charges for
unbilled time and costs

Post to multiple accounts receivable and accounts payable lines in a single journal entry

Track inventory using the first in, first out (FIFO) method (the only QuickBooks Desktop edition
that offers FIFO inventory costing is QuickBooks Desktop Enterprise with Advanced Inventory)

® Track logins, third-party activity and list changes in the Audit Log

® Reports can be emailed to anyone at a scheduled frequency, even if they do not have access to
this QuickBooks Online company file

® Further organize data with both class and location tracking; labels can be selected for locations
(such as property, store, territory, etc.)

Bank transactions are automatically downloaded nightly
Invite unlimited “reports only” and “time tracking only” users

® Sync third-party apps to QuickBooks Online without opening the QuickBooks Online company,
since the apps sync to Intuit’'s always-accessible server; no downloading and managing third-
party sync engines

® QuickBooks Online developers are always releasing new functionality to QuickBooks Online (no

need to install new versions of QuickBooks Online as you always get the latest and the greatest
with new features users are requesting)
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KNOW THE FEATURES OF YOUR QUICKBOOKS ONLINE SUBSCRIPTION

QuickBooks Online is a great solution for many different types of businesses. Every company must
assess their needs to find a financial accounting solution appropriate for their business. Use the
QuickBooks Online subscription matrix to determine the features of your QuickBooks Online
subscription: http://quickbooks.intuit.com/online/compare. You can upgrade your QuickBooks
Online subscription at any time to accommodate changes in your business.

QuickBooks Online Simple Start

QuickBooks Online account
Automatic data backup

Bank-level security and encryption
One full-access user

Invite up to two accountant users, no
additional charge

® Unlimited invoices and estimates

® Charge sales tax to customers

® Snap photos of receipts so you're ready for

tax time

Up to 250 accounts on the Chart of Accounts

Print checks and record transactions
Download bank and credit card transactions
Import from QuickBooks Desktop

Import/export lists from Microsoft Excel®
(customers, vendors, Chart of Accounts)

Add payroll to pay W-2 employees and file
payroll taxes

Prepare and print 1099-Misc
Integrate with available applications

20+ built-in reports
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QuickBooks Online Essentials

With QuickBooks Online Essentials you have access to all the Simple Start features as well as:

@ Access for three users with permission ® Unlimited time tracking-only users
controls
® Compare sales profitability with industry
® Manage and pay bills, including schedule trends
payments for later
® Delayed charges and credits
@® Automatic invoice creation on recurring
schedule ® Multicurrency

® Track billable hours by customer ® 40+ built-in reports

QuickBooks Online Plus

With QuickBooks Online Plus you have access to all the Essentials features as well as:

® Access for five users with permission controls @ Track inventory using the FIFO method
® Unlimited reports-only users ® Budgets
® Track billable hours by customer ® Two-sided items for profitability tracking
® Purchase orders ® Estimates
® Class and location tracking: up to 40 total ® 65+ built-in reports

classes and locations
® Track project profitability
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QuickBooks Online Advanced

With QuickBooks Online Advanced, you have access to all the Plus features as well as:

@® Access for 25 users with advanced @® Enhanced custom fields
permission controls

® Prioritized technical support calls
Import or send hundreds of invoices at once
® Training
Get help from a dedicated Customer Success
Manager ® |Invite up to three accountant users, no
additional charge
® Accessto Smart Reporting powered by

Fathom @® Unlimited accounts on the chart of accounts

® Unlimited class and location tracking
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Topic 2: Import Data

IDENTIFY STEPS TO IMPORT DATA INTO QUICKBOOKS ONLINE

When you sign in to your company you can click the Help button (the question mark in the circle or
the word Help next to it) in the top right corner for access to in-product self-help resources such as
overviews and videos, as well as a Contact Us button with various options for ways to connect.

J
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QuickBooks Online allows users to import data from QuickBooks Desktop within the first 60 days of
creating the QuickBooks Online account. When this data is imported, it replaces (i.e., overwrites) any
pre-existing data in the QuickBooks Online account.

Most QuickBooks Desktop data can be imported, but there are some limitations. Because
QuickBooks Online is being improved constantly, the import capabilities can change. Check the
latest details and limitations by visiting Move your QuickBooks Desktop file to QuickBooks Online
and What to expect when you switch from QuickBooks Desktop to QuickBooks Online. At the time
of this publication, these guidelines are among those in effect:

® While the size of the QuickBooks Desktop company file does not matter when importing to
QuickBooks Online, the Desktop file must consist of no more than 350,000 targets

® If the Desktop file consists of more than 350,000 targets, consult Condense your QuickBooks
Desktop file for import to QuickBooks Online for alternatives regarding trimming the file or
importing lists and/or balances only

® Form templates (such as invoices, credit memos, statements, etc.) from QuickBooks Desktop
cannot be brought into QuickBooks Online

® Memorized reports from QuickBooks Desktop cannot be brought into QuickBooks Online
® Reconciliation reports from QuickBooks Desktop cannot be brought into QuickBooks Online

® Payroll data imports from QuickBooks Desktop to QuickBooks Online as checks, not paychecks;
any desired payroll service will have to be newly set up in QuickBooks Online via an interview
including calendar YTD fields for each employee

@ |International versions of QuickBooks Desktop cannot be imported into QuickBooks Online’s U.S.
version

® You can import your QuickBooks Online data back to QuickBooks Desktop, with limitations,
using Internet Explorer (consult Export and convert your QuickBooks Online data to QuickBooks
Desktop for instructions). enter Export data file from QuickBooks Online to Desktop in the search
bar and follow those instructions)
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)

o  Step by Step: Export QuickBooks Desktop Data to QuickBooks Online

These steps are for exporting a QuickBooks Desktop (Pro or Premier) company to QuickBooks
Online. These steps can be followed using a QuickBooks Desktop sample company to try out the
process. There are different steps for converting from QuickBooks Enterprise Solutions or
QuickBooks for Mac to QuickBooks Online; visit Move your QuickBooks Desktop file to QuickBooks
Online for instructions.

The QuickBooks Online file should be set up ahead of time by the client or by the accountant
creating a QuickBooks Online file on behalf of the client. If it is not set up ahead of time, you will be
prompted to do so when you find that there is no QuickBooks Online filename where the converted
Desktop file's records can reside.

1. Open the QuickBooks Desktop company data file as the Admin user.

2. The file cannot have more than 350,000 targets. To view the size of your file, press the F2 key. If
the file has more than 350,000 targets, you can still import lists.

3. Navigate to File > Utilities > Verify Data. Correct any errors in the QuickBooks Desktop data
before proceeding to the next step and, if necessary, perform step 3 and repeat Verify.

4. Navigate to File > Utilities > Rebuild data. A backup must be created before QuickBooks
Desktop runs the Rebuild action. Always perform a Rebuild using a computer that has a copy of
the data stored locally.

5. Navigate to Company > Export Company File to QuickBooks Online.

| Customers Vendors Employees Ban

Home Page
Company Snapshot
Calendar

Documents »
Lead Center
My Company
Set Up Users and Passwords 3

Customer Credit Card Protection...
Set Closing Date. ..
Bulk Enter Business Details...

Planning & Budgeting 3
To Do List

Reminders

Alerts Manager

Chart of Accounts Ctrl+A
Make General Journal Entries...
Manage Currency 3

Enter Vehicle Mileage...

Prepare Letters with Envelopes 3

Export Company File to QuickBooks Online
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6. You will then see a window with a link to a guide about how to make the conversion from
QuickBooks Desktop to QuickBooks Online as smooth as possible, and a link to a quick tour of
the QuickBooks Online interface. Both are very useful, especially the guide, as there are
embedded links and it is constantly being updated. When you are ready, click Start your export.

CJ

The wizard will provide the steps to sign in with your pre-existing Intuit user ID.
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7. If the QuickBooks Desktop company file you are exporting has inventory set up, you will see: Do
you want to bring over inventory? Specify if you wish to bring over inventory (and as of what
date) or not. Select Continue.

8. You will then be given the opportunity to overwrite any of the new companies on the drop-down
list (60 days old or newer) associated with that ID.
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9. If you don't see the company you want in the list, that's because it hasn't been created in
QuickBooks Online first. You should have created the "empty” QuickBooks Online company first
to ensure it appears on this list. Then you'll be able to select it and click Continue.
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10. You will be asked to confirm if you want QuickBooks to replace all the data in the existing
QuickBooks Online company file you chose (even if it's a new empty one that you just created).

Be very careful with this step as it will overwrite all data in the QuickBooks Online company that
you select, as it was created already and is 60 days old or newer.

You will see a summary of what data will be overwritten and you will be prompted to confirm you
wish to go ahead and replace the data. Check the box to go ahead and replace in the field below

then click Replace.
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Export to QuickBook

Preparing Rock Castle Construction...

This process may take up to 30 minutes.

11. Once complete, wait for confirmation that the QuickBooks Desktop file has been successfully
imported.
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An email will be sent once the conversion is finished notifying you that your QuickBooks Online
company is ready. Often the conversion is very quick and email confirmation is received almost
immediately.

Verify the data was imported correctly. Create a Balance Sheet and Profit & Loss report in both
QuickBooks Online and Desktop. Customize the date range to All Dates. Set the accounting
method to Accrual. Compare the balances, looking for any inconsistencies. (Inconsistencies may be
addressed here, due to cash vs. accrual basis reporting, FIFO inventory vs. weighted average
inventory, and certain types of multicurrency transactions.)

You can re-import data into QuickBooks Online for 60 days from the creation date of the
QuickBooks Online company.

Warning: Re-importing data will overwrite any existing data in the QuickBooks Online company.
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@)
o  Step by Step: Import Lists into QuickBooks Online

1. Open the QuickBooks Online test drive account.

2. Navigate to the gear icon - Import Data under the Tools section.

List data may be imported at any time into QuickBooks Online, such as customers, vendors,
accounts (i.e., general ledger accounts on the Chart of Accounts) or products and services. Each
option has a downloadable template to ensure data is properly formatted before import.

NoTE: When importing a Chart of Accounts, it does not replace the existing Chart of Accounts; it adds
any accounts in your spreadsheet that are not already in QuickBooks Online to the existing accounts.

In addition, bank and credit card statements can be manually uploaded and imported (in *.csv, *.gfx,
*.gqbo, or *.ofx format) into QuickBooks Online when a direct bank feed connection to online
banking cannot be established. To establish a bank feed connection, you can connect an online
bank or credit card account to the appropriate account on the Chart of Accounts by navigating to
the left navigation bar, selecting Banking > Add account in the top right corner. Future bank and
credit card statements can be uploaded manually either from the gear icon > Import Data > Bank
Data access point or select Banking on the left navigation bar then select File Upload (or, if the File
Upload button is not displayed, select the drop-down next to Update then select File Upload).
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Topic 3: Set Up Your Company

RECOGNIZE STEPS TO SET UP AND MODIFY LISTS AND USERS

QuickBooks Online account lists and users can be managed from the gear icon in the top right.
Managing lists is an important component of QuickBooks Online. From the gear icon, all lists should
be reviewed to make sure they are appropriate for the company. This includes the Chart of
Accounts, Recurring Transactions, Products and Services, Product Categories, Custom Form Styles,
Payment Methods, Terms, Attachments, and, if turned on in QuickBooks Online Plus or Advanced,
Classes and Locations.

)

2.  Step by Step: Add Users to QuickBooks Online

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Manage Users under the Your Company section.

3. Ensure the Users tab is selected; the total number of existing users displays in the name of the
tab.

4. Click Add user.

5. Choose atype of user.

6. Click Next.

7. Setthe user’s access rights.

8. Click Next.
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9. Select the user’s settings.

10. Click Next.

11. Enter the user’'s name and email address; the email address will be their Intuit user ID.

12. Click Save.

The invited user receives an email that contains a link to sign in to the QuickBooks Online company.

@
2.  Step by Step: Add Accountant Users to QuickBooks Online

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Manage Users under the Your Company section.

3. Ensure the Accounting firms tab is selected; the total number of existing Accounting firm users
displays in the name of the tab.

4. Enter the accountant’'s email address; your accountant/bookkeeper and members of their firm
who have been granted permission will have access to your company data.

5. Click Invite.

The accountant receives an email that contains a link to sign in to the client’'s company via
QuickBooks Online Accountant as an Accountant user.
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@)
2.  Step by Step: Products and Services List

1. Open the QuickBooks Online company.
2. Navigate to the gear icon - Products and Services under the Lists section.

3. The Products and Services list appears. Notice that it lists the name, SKU, type, sales description,
sales price, cost, whether the item is taxable, the quantity on hand and the reorder point (if it's set
up as an inventory item). The items will be grouped by categories, if product categories are used.
Additionally, a picture of the product or service can accompany the name of the item.

4. To specify the columns which appear in the Products and Services list, click the grid gear icon at
the top right of the list and add or remove the checkmark next to each column you want to see or
not see. Click the grid gear icon again to have that list of columns disappear. You can also
decide how many rows you want to appear on one page for this list (50, 75, 100, 150, or 300), if
you wish to have a compact display, and if you wish for the product and service items to appear
grouped by category.
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5. To edit an item, locate the item to be changed, then click Edit in the far right column for that
item. Make the necessary edits. Save and Close.

6. To add an item, click New in the top right corner of the Products and Services window.
a. Select a Type for this product/service (Inventory, Non-inventory, Service or Bundle).

b. The Product/Service information window appears; if you selected the wrong type of
product/service, select Change type and correct your selection.

c. Enterthe item Name, and, if applicable, the SKU and Category for the product/service.
d. Upload a picture for this product/service if desired.

e. ForlInventory items in companies that have no history of transactions for an item in
QuickBooks Online, specify the Initial quantity on hand (zero for new products) and the As
of date for that initial quantity. (Ensure the As of date is dated far enough back in time that it
pre-dates any live transactions you might want to enter.) You can specify a Reorder point if
desired. Also, for any Inventory items, you would select the Inventory asset account.

f.  Fill in the Sales information and Purchasing information for that product/service with the
corresponding default sales description, sales price/rate, income account, taxable status,
default purchase description, unit cost and expense account. If applicable, specify the
Preferred Vendor. Save and close or Save and new.
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7. To delete (deactivate) an item, locate the item, click the drop-down arrow next to Edit and click
Make inactive.

8. Click Yes to confirm. Notice that items (and all list names, for that matter,) are merely inactivated
and not really deleted. Transactions for inactivated items are never deleted.

NOTE: The Products and Services list has two other access points. The first is accessed by selecting
Sales in the left navigation bar > Products and Services. The second is accessed by selecting the
gear icon > All Lists under Lists > Products and Services.

@
2. Step by Step: Print a Transactions Report for a Selected Account

Directly from the Chart of Accounts
1. Open the QuickBooks Online company.
2. Click the gear icon > Chart of Accounts under Your Company.
3. If prompted, click See your Chart of Accounts.

4. Select an existing account that is a Balance Sheet type of account (i.e., the Type column has any
of these in it: Bank, Accounts Receivable, Other Current Assets, Fixed Assets, Other Assets,
Accounts Payable, Credit Card, Other Current Liabilities, Long Term Liabilities or Equity), and in
the drop-down next to View Register for that account, click Run report.

5. The Account QuickReport for that account will display.
6. Change the Report period in the top left corner, if necessary, and click Run Report.
NOTE: The Chart of Accounts has two other access points. The first is accessed by selecting

Accounting in the left navigation bar - Chart of Accounts. The second is accessed by selecting the
gear icon 2 All Lists under Lists - Chart of Accounts.
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@)
2. Step by Step: Print the Chart of Accounts

1. Open the QuickBooks Online company.
2. Click the gear icon - Chart of Accounts under Your Company.
3. If prompted, click See your Chart of Accounts.

4. Click the Printer icon in the upper right-hand corner of the displayed Chart of Accounts (just
above the Action column).

-

o

5. The Chart of Accounts will display in print preview format. In the left column, select your printer
and print settings, if necessary, and select Print.

@
2.  Step by Step: Connect a Bank Account to the Bank Feed

1. Open the QuickBooks Online company.
2. From the left navigation bar, click Banking.

3. Click Add Account in the top right-hand corner.

4. Follow the wizard to connect an account to the bank feed.
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RECOGNIZE STEPS TO MANAGE YOUR COMPANY ACCOUNT AND SETTINGS

Your company Account and Settings control much of the functionality in the QuickBooks Online
account. They are the foundation for a successful and efficient QuickBooks Online experience.

The Account and Settings screen organizes the account’s global preferences into these sections:

Company

Billing & Subscription
Usage

Sales

Expenses

Payments

Advanced

NOTE: Two of these Account and Settings sections — Billing & Subscription and Payments — do not
appear in the test drive company file.
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)

o Step by Step: Company Tab in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings under Your company.

3. Onthe Account and Settings page, click the Company section on the left.

4. Notice the settings can be updated by clicking Edit (the pencil icon) on the right or click

anywhere in that area.

® Company name

Company type

Contact info

Address

Communications with Intuit

2.  Step by Step: Enter Company Name, EIN, Industry, Contact Information
and Tax Form in Account and Settings
1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. On the Account and Settings page, click the Company section on the left.

4. Find the Company name settings and click Edit (the pencil icon) on the right or click anywhere in
that area to enter or edit the company name information.

5. Enter the Company name, the Legal name, and the EIN or SSN.

6. Click Save.

7. Find the Company type settings and click Edit (the pencil icon) on the right or click anywhere in
that area to enter or edit the company type information.

8. Choose a Tax form from the drop-down list.

9. Inthe Industry list, start entering an industry and finish by selecting one from the list that appears.

10. Click Save.
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11. Find the Contact info settings and click Edit (the pencil icon) on the right or click anywhere in
that area to enter or edit the company contact information.

12. Click Save.

13. Click Done.

@
2.  Step by Step: Specify Terminology for Customers in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. Onthe Account and Settings page, click the Advanced section on the left.

4. Find the Other preferences settings and click Edit (the pencil icon) on the right (or click
anywhere in that section) to enter or edit the Customer Label (Clients, Customers, Donors,
Guests, Members, Patients, or Tenants).

5. Click Save.

6. Click Done.

)
o Step by Step: Sales Tab in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. On the Account and Settings page, click the Sales section on the left.

4. Notice that the settings can be updated by clicking Edit (the pencil icon) on the right or
anywhere in each area.

Customize (i.e., customize the look and feel of forms for customers)
Sales form content

Products and services

Late fees

Progress Invoicing

Messages

Reminders

Online delivery

Statements
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2.  Step by Step: Turn on Inventory in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings under Your company.

3. Onthe Account and Settings page, click the Sales section on the left.

4. Find the Products and services area and click Edit (the pencil icon) or click anywhere in that area.

5. Ensure you've clicked the box next to Show Product/Service column on sales forms, so these
fields appear on sales forms.

6. Click the box next to Track quantity and price/rate, so these fields appear on sales forms.
7. Click the box next to Track inventory quantity on hand, so inventory is tracked.

8. Click Save.

9. Click Done.

10. Click the gear icon in the upper right.

11. Click Products and Services under Lists.

12. Select New to create a new product or Edit to alter an existing product.

13. If it's an existing product, select Change Type and choose Inventory. If it's a new product,
choose the type Inventory.

14. Enter or edit the item Name and, if applicable, the SKU and Category for the product/service.
15. Upload a picture for this product/service if desired.

16. For Inventory items in companies that have no history of transactions for an item in QuickBooks
Online, specify the Initial quantity on hand (zero for new products) and the As of date for that
initial quantity. (Remember to back-date that As of date sufficiently to pre-date any live
transactions you will enter.) You can also specify a Reorder point if desired and, for any
Inventory items, you would select the Inventory asset account.

17. Fill in the Sales information and Purchasing information for that product/service with the
corresponding default sales description, sales price/rate, income account, taxable status, default
purchase description, unit cost and expense account. If applicable, specify the Preferred Vendor.

18. Click Save and close or Save and new.
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@
2. Step by Step: Expenses Tab in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. Onthe Account and Settings page, click the Expenses section on the left.

4. Notice the settings can be updated by clicking Edit (the pencil icon) on the right or anywhere in
each area.

® Bills and expenses
® Purchase orders
® Messages

@
o  Step by Step: Explore Purchase Orders in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. On the Account and Settings page, click the Expenses section on the left.

4. Find the Purchase Orders area and click Edit (the pencil icon) on the right or anywhere in that
area.

5. Click the box next to Use Purchase Orders.
6. Fill out remaining fields as needed.
7. Click Save.

8. Click Done.
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o  Step by Step: Advanced Tab in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. Onthe Account and Settings page, click the Advanced section on the left.

4. Notice that the settings can be updated by clicking Edit (the pencil icon) on the right or
anywhere in each area.

® Accounting - to change the fiscal year or close the books
® Company type - sole proprietorship, etc. (also accessible on the Company page)

® Chart of Accounts - to turn account numbers on or off, specify a Discount account, specify a
Tips account and specify a billable expense markup income account if required

Categories - tracking classes, locations, or both
Automation

Projects

Time tracking

Currency

Other preferences

o Step by Step: Close the Books in Account and Settings

1. Open the QuickBooks Online company.

2. Onthe Account and Settings page, click the Advanced section on the left.

3. Find the Accounting settings. Click Edit (the pencil icon) on the right or anywhere in that area.
4. Check the box next to Close the books.

5. Enter a Closing Date.

6. Select one of these from the drop-down menu: Allow changes after viewing a warning or
Allow changes after viewing a warning and entering a password. The password option is
recommended.

7. Enter a password and confirm the password (if the password option was selected).
8. Click Save.

9. Click Done.
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@
2.  Step by Step: Show Account Numbers in Account and Settings

1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. Onthe Account and Settings page, click the Advanced section on the left.

4. Find the Chart of Accounts settings. Click Edit (the pencil icon) on the right or anywhere in that
area.

5. Check the box next to Enable account numbers.

6. Click the box next to Show account numbers.

7. Click Save.

8. Click Done.

9. Click the gear icon > Chart of Accounts under Your Company.
10. If you are prompted, click See your Chart of Accounts.

11. Select the Checking account. Select the drop-down arrow next to View Register for that
account and select Edit.

12. Edit the Checking account. In the Number field, enter account number 70700. Save and Close.
13. View the account number now showing in the Chart of Accounts list.
14. Navigate to Reports > Balance Sheet.

15. View the account number for the Checking account appearing on the Balance Sheet.
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2. Step by Step: Enable Auto-recall on Forms in Account and Settings

1. Open the QuickBooks Online company.

2. Navigate to the gear icon > Account and Settings under Your company.

3. Onthe Account and Settings page, click the Advanced section on the left.

4. Find the Automation settings. Click Edit (the pencil icon) on the right or anywhere in that area.

5. Check the box to Pre-fill forms with previously entered content.

6. Click Save.
7. Click Done.
@

o  Step by Step: Enter/Edit Many Account Numbers at Once in
Chart of Accounts
1. Now that Account Numbers have been enabled, open the Chart of Accounts.
2. Click Edit (the pencil icon) in the top right corner.

3. The Chart of Accounts becomes a grid you can edit, and you can add/edit account numbers in
the Number column for many account numbers at once.

4. When you are finished adding or editing your account numbers, click Save. (Tip: you can use this
same method to edit the names of many accounts at once on the Chart of Accounts.)
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@
2.  Step by Step: Change Settings for Automatic Sign Out

after a Period of Inactivity
1. Open the QuickBooks Online company.
2. Navigate to the gear icon > Account and Settings under Your company.
3. On the Account and Settings page, click the Advanced section on the left.

4. Find the Other preferences settings. Click Edit (the pencil icon) on the right or anywhere in that
area.

5. Select 1 hour, 2 hours or 3 hours from the drop-down list next to Sign me out if inactive for.
6. Click Save.

7. Click Done.
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Guide Conclusion

You have just covered Course 1 - Get Started. This course has been developed to help you train your
clients how to use QuickBooks Online successfully.

By completing this module, your client should understand:

@® The benefits of QuickBooks Online
® How to import data

® The parameters of setting up their company
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